# Table of Contents

PC Wallboard........................................................................................................................................ 5
General.................................................................................................................................................. 5
Starting PC Wallboard ......................................................................................................................... 6
Menu Bar Options................................................................................................................................ 7
Templates............................................................................................................................................... 8
Customise a Template.......................................................................................................................... 9
  Blank area........................................................................................................................................... 9
  Existing Pane................................................................................................................................... 10
Display Setup Wizard ........................................................................................................................... 11
Callback Request Messages .................................................................................................................. 12
Display Field/Message Bar Properties .............................................................................................. 13
Message Display Bar Properties ......................................................................................................... 13
Marquee Display Properties ............................................................................................................... 13
LED Display Properties ..................................................................................................................... 13
Index................................................................................................................................................... 15
PC Wallboard

General
The PC Wallboard allows full Wallboard functionality to be displayed on a Windows PC. Messages are scheduled on the PC Wallboard via the Wallboard Server.

The PC Wallboard operates in two modes:

**Enhanced Compact Contact Center agent mode.**
If the PC Wallboard is to be run on a PC, then the agent must be logged on to the Telephone system prior to invoking the PC Wallboard. The agents log on to the PC Wallboard using their individual agent logon ID. The currently logged on agent can view their own personalised configuration of the contact center consisting of up to 20 contact center variables and the scheduled messages.

**Standard User mode.**
Displays only the scheduled messages received from the Wallboard Server/Client applications. In this mode you logon to the PC Wallboard using alphanumeric text.

If the PC Wallboard application is minimised, whenever a message of a priority greater than 6 is in Active status, the PC Wallboard is designed to pop up to display the message.

A maximum of 250 PC Wallboards can concurrently be connected to a single Wallboard Server.
Starting PC Wallboard
Before starting the PC Wallboard, you MUST ensure that the Wallboard Server is running and that you (the agent) have logged on to the Telephone system.

To start the PC Wallboard:
1. Click the Start button on the Windows taskbar.
2. Point to Programs.
3. Point to CCC.
4. Click PC Wallboard from the sub-menu.
5. Type the Login ID and the name of the PC hosting the Wallboard Server. The Login ID can either be:
   - an agent’s directory number (e.g. 5001), enabling you to select and monitor agent’s variables;
   - an alphanumeric text (e.g. PCW01); enables you to use the PC Wallboard as a display device. In this format, only the Message Display bar is displayed.
6. Click Login. The Message Display bar, displays the scheduled messages that are currently active on the Wallboard Server. The PC Wallboard screen can also be reduced to only display the Message Display bar. To only display the Message Display bar select Compact from the View menu.
**Menu Bar Options**

The **File** menu incorporates the following options:

- **New**: Enables you to select a template. PC Wallboard provides 7 templates which can be customised and saved as a new template.
- **Save**: Ensures that changes made to the current user interface are saved.
- **Save Template As**: Enables you to save the current customized template under a different name.
- **Exit**: Enables you to exit the PC Wallboard.

The **View** menu incorporates the following options:

- **Toolbar**: Allows you to toggle between hide or display Toolbar.
- **Status Bar**: The Status Bar provides information about which directory number is being monitored and if connection is established as well as the current data and time.
- **Always on Top**: Allows you to toggle between On and Off. If this option is selected the PC Wallboard is always on top of all the other active window applications.
- **Compact**: Allows you to use the PC Wallboard as a display device. You can use your right hand button and select Restore, or double click the display bar to restore to full screen.
- **Callback Requests**: Displays a list of Callback request messages actioned from the Call Center View.

The **Setup** menu incorporates the following options:

- **Language**: Enables you to select the required language. The PC Wallboard will automatically change to the selected language.
**Templates**

When you first log in, you are presented with a Messages Display bar and an empty panel below it. You can use the available templates or configure the blank panel for size, colour, display feature and variable.

**Note:** You can also customise the available templates and save it as a new template.

To open a Template:

1. From File menu select New, or click the icon on the Toolbar.
2. Select the required template. When you click any of the available templates a preview will show.
3. Click Ok when you have decided on which template you want to use.
Customise a Template.
To customise an existing template or create a new template, you can use your right mouse button to click anywhere in the Display Panel and see a menu of available commands. The commands are different if you click an existing pane or within a blank area.

Blank area.
If you click using your right mouse button in a blank pane, you get the following options.

- **Split Pane:**
  - **Horizontally** – New pane on Top or Bottom.
  - **Vertically** – New Pane on Left or Right. This option allows you to divide the panel either horizontally (top/bottom) or vertically (left or right) as required into several partitions.

- **Remove Pane**: Removes the selected pane.

- **Display Setup Wizard**: This option invokes the wizard to select the agent’s variable.
**Existing Pane**

The pop-up menu that appears when you right mouse click within a template contains the following options.

- **Properties**: When you select this option a screen will show. This will allow you to format the selected area of the PC Wallboard display.

  ![Properties Window](image)

  - **Digits**: 4
  - **Decimal size**: 4
  - **Decimals**: 1
  - **Decimal position**: 0
  - **Background**
    - **Bevel width**: 1
    - **Inner bevel**: None
    - **Border width**: 0
    - **Outer bevel**: Inset
  - **Off Colour**
  - **On Colour**
  - **Back Colour**

- **Variables**: When you choose this option you will be able to go through a display setup wizard (see page 11) which allows you to select the variables that you want to view on your PC Wallboard.

- **Remove**: If you select this option, you will remove the selected pane.
Display Setup Wizard

The display Setup Wizard allows you to configure the selected panel to display the variable data for the current logged on directory number. The panel can be configured to display up to 20 variable data fields.

1. Click the right hand mouse button on a panel and from the available menu options, select Display Setup Wizard. The Display Setup Wizard appears.

2. The available field options are:
   - Marquee: Displays a horizontally scrolling text message;
   - LED: displays the message in digital layout.

3. Select the required field. Click Next to proceed to select the required Variable.

4. Click Next to select the required directory number. Click Refresh to ensure that all the available directory numbers are listed.

5. Click Next to select the position of a label if one is required. Modify the label message as required and then click Finish.

- **Popup if Value Changes**: If the PC Wallboard is minimised, when the value of a variable changes, this will cause the PC Wallboard screen to pop-up (i.e. maximise) with the variable value flashing.

- **Maximise Message Bar**: When the PC Wallboard is running in ‘compact mode’ i.e. with only the Message Bar being displayed, then, when the value of a variable changes, this will cause the PC Wallboard screen to pop-up (i.e. restore) with the variable value flashing.
Callback Request Messages

When you receive a Callback Request message from the Call Center View, the Callback Request button on the toolbar flashes 🔄. Click the button and the Callback Requests screen appears, listing the Callback Request message(s).

You must enter the Digit(s) required for accessing the outside line. This number is configured within the telephone system.

The Callback Request command buttons are:

**Make Callback**: Click a callback message and then click Make Callback to make the call.

**Callback Succeeded**: If the called party is the intended recipient, then during the call, click Callback Succeeded. This is for historic report purposes to indicate the callback was successful. Further details are available from the “Agent Callback Request Report”.

**Callback Failed**: If the called party is not the intended recipient, the line was busy or no answer, then during the call, click Callback Failed. This is for historic report purposes to indicate the callback was not successful. Further details are available from the “Agent Callback Request Report”.

**Clear Callback**: When you have finished with the call, you must click Clear Callback to inform the Contact Center View Supervisor you have responded to the callback message. “Cleared” will be displayed in the Callback Request screen within the Contact Center View application.

The information on the screen is:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLI</td>
<td>Number to call</td>
</tr>
<tr>
<td>Time</td>
<td>Time the callback Request message was sent from CCV</td>
</tr>
<tr>
<td>Date</td>
<td>Date the callback Request message was sent from CCV</td>
</tr>
<tr>
<td>XXXX</td>
<td>Shows the subject that the caller requested a callback for</td>
</tr>
</tbody>
</table>
Display Field/Message Bar Properties
Embedded with each selected Display Field and the Message Bar, there is a Properties screen. This also applies to the Label of the Display Field. Using the Properties option, you can customise the look and feel of the selected section.

Message Display Bar Properties
Right click (using right hand mouse button) anywhere on the Message Display Bar. Select Properties from the available commands, the Properties screen appears.
Configure the required features.
You can change the number of times the message scrolls and the pause time between each scroll. You can also change the background colour together with the font of the message.

Marquee Display Properties
Right click (using right hand mouse button) anywhere on the Display Field (Marquee). Select Properties from the available commands, the Properties screen appears.
Configure the required features.
You can change the number of times the message scrolls (if the style is set to Scroll) and the pause time between each scroll. You can also change background colour and the font of the message.

LED Display Properties
Right click (using right hand mouse button) anywhere on the Display Field. Select Properties from the available commands, the Properties screen appears.
Configure the required features.
You can change the number of digits, the decimal size, the number of decimals and the decimal position. You can also select a different background colour and the colour of the digits.
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B</strong></td>
</tr>
<tr>
<td><strong>C</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>D</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>M</strong></td>
</tr>
<tr>
<td><strong>P</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Performance figures and data quoted in this document are typical, and must be specifically confirmed in writing by Avaya before they become applicable to any particular order or contract.

The company reserves the right to make alterations or amendments to the detailed specifications at its discretion. The publication of information in this document does not imply freedom from patent or other protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

This document contains proprietary information of Avaya and is not to be disclosed or used except in accordance with applicable agreements.

Any comments or suggestions regarding this document should be sent to "wgctechpubs@avaya.com".

© 2005 Avaya Inc. All rights reserved.

Avaya
Sterling Court
15 - 21 Mundells
Welwyn Garden City
Hertfordshire
AL7 1LZ
England
Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933
Web: http://www.avaya.com